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Minimum of 5 experiments are to be conducted from each

Part - Software Experiments (PART — A)

1 Generation of random signal and plot the same as a waveform showing all the 16-17
specifications

2 Finding Power and (or) Energy of a given signal. 18-19

3 Convolution and Correlation (auto and cross correlation) of discrete sequences 20-28

without using built in functions for convolution and correlation operations.

4 DTFT of a given signal 29-44
5 N — point FFT algorithm 45-46
6 Design of FIR filter using windowing technique and verify the frequency 47-53

response of the filter

7 Design of IIR filter using any of the available methods and verify the frequency 54-56

response of the filter.

8 Design of analog filters. 57-58

Using DSP Processor Kkits (Floating point) and Code Composure Studio
(CCS)(PART - B)

1 Generation of random signal and plot the same as a waveform showing all the 71-72
specifications.
2 Finding Power and (or) Energy of a given signal. 73-74

Design of FIR filter using windowing technique and verify the frequency

response of the filter.

3 Convolution and Correlation (auto and cross correlation) of discrete sequences 75-79

without using built in functions for convolution and correlation operations.

4 DTFT of a given signal 80
5 N — point FFT algorithm 81-83
6 Design of FIR filter using windowing technique and verify the frequency 84

response of the filter

7 Design of IR filter using any of the available methods and verify the frequency 85-86

response of the filter.

8 Design of analog filters. 87-88

JAWAHARLAL NEHRU TECHNOLOGICAL UNIVERSITY ANANTAPUR
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B. Tech III-II Sem. (ECE) LTPC 0042

15A04608 DIGITAL SIGNAL PROCESSING LABORATORY
Course Outcomes:
* Able to design real time DSP systems and real world applications.
* Able to implement DSP algorithms using both fixed and floating point processors.
List of Experiments: (Minimum of 5 experiments are to be conducted from each part)
Software Experiments (PART — A)
1. Generation of random signal and plot the same as a waveform showing all the specifications.
2. Finding Power and (or) Energy of a given signal.

3. Convolution and Correlation (auto and cross correlation) of discrete sequences without using built in
functions for convolution and correlation operations.

4. DTFT of a given signal

5. N —point FFT algorithm

6. Design of FIR filter using windowing technique and verify the frequency response of the filter.

7. Design of IR filter using any of the available methods and verify the frequency response of the filter.
8. Design of analog filters.

Using DSP Processor Kkits (Floating point) and Code Composure Studio (CCS) (PART - B)

1. Generation of random signal and plot the same as a waveform showing all the specifications.

2. Finding Power and (or) Energy of a given signal.

3. Convolution and Correlation (auto and cross correlation) of discrete sequences without using built in
functions for convolution and correlation operations.

4. DTFT of a given signal

5. N — point FFT algorithm

6. Design of FIR filter using windowing technique and verify the frequency response of the filter.

7. Design of IR filter using any of the available methods and verify the frequency response of the filter.
8. Design of analog filters

Equipment/Software Required:

1. Licensed MATLAB software with required tool boxes for 30 users.

2. DSP floating Processor Kits with Code Composure Studio (8 nos.),Function generators,CROs,Regulated
Power Supplies

ECE DEPT VISION & MISSION PEOs and PSOs
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Vision

To produce highly skilled, creative and competitive Electronics and Communication Engineers to meet the
emerging needs of the society.

Mission

» Impart core knowledge and necessary skills in Electronics and Communication Engineering through
innovative teaching and learning.

» Inculcate critical thinking, ethics, lifelong learning and creativity needed for industry and society

» Cultivate the students with all-round competencies, for career, higher education and self-
employability

I. PROGRAMME EDUCATIONAL OBJECTIVES (PEOS)

PEOL: Graduates apply their knowledge of mathematics and science to identify, analyze and solve
problems in the field of Electronics and develop sophisticated communication systems.

PEO2: Graduates embody a commitment to professional ethics, diversity and social awareness in
their professional career.

PEO3: Graduates exhibit a desire for life-long learning through technical training and professional
activities.

I1. PROGRAM SPECIFIC OUTCOMES (PSOS)

PSOL1: Apply the fundamental concepts of electronics and communication engineering to design a
variety of components and systems for applications including signal processing, image
processing, communication, networking, embedded systems, VLSI and control system

PSO2: Select and apply cutting-edge engineering hardware and software tools to solve complex
Electronics and Communication Engineering problems.

IIT. PROGRAMME OUTCOMES (PO’S)
1. Engineering knowledge: Apply the knowledge of mathematics, science, engineering fundamentals, and

an engineering specialization to the solution of complex engineering problems.

2. Problem analysis: Identify, formulate, review research literature, and analyze complex engineering
problems reaching substantiated conclusions using first principles of mathematics, natural sciences, and
engineering sciences.

3. Design/development of solutions: Design solutions for complex engineering problems and design system
components or processes that meet the specified needs with appropriate consideration for the public health
and safety, and the cultural, societal, and environmental considerations.

4. Conduct investigations of complex problems: Use research-based knowledge and research methods
including design of experiments, analysis and interpretation of data, and synthesis of the information to
provide valid conclusions.

5. Modern tool usage: Create, select, and apply appropriate techniques, resources, and modern engineering
and IT tools including prediction and modeling to complex engineering activities with an understanding of
the limitations.
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6. The engineer and society: Apply reasoning informed by the contextual knowledge to assess societal,
health, safety, legal and cultural issues and the consequent responsibilities relevant to the professional
engineering practice.

7. Environment and sustainability: Understand the impact of the professional engineering solutions in
societal and environmental contexts, and demonstrate the knowledge of, and need for sustainable
development.

8. Ethics: Apply ethical principles and commit to professional ethics and responsibilities and norms of the
engineering practice.

9. Individual and team work: Function effectively as an individual, and as a member or leader in diverse
teams, and in multidisciplinary settings.

10. Communication: Communicate effectively on complex engineering activities with the engineering
community and with society at large, such as, being able to comprehend and write effective reports and
design documentation, make effective presentations, and give and receive clear instructions.

11. Project management and finance: Demonstrate knowledge and understanding of the engineering and
management principles and apply these to one’s own work, as a member and leader in a team, to manage
projects and in multidisciplinary environments.

12. Life-long learning: Recognize the need for, and have the preparation and ability to engage in
independent and life-long learning in the broadest context of technological change.

IV. COURSE OBJECTIVES

» To familiarize the students with basic analog communication systems.

Y

Integrate theory with experiments so that the students appreciate the knowledge gained from the
theory course.

Understand all types of analog modulation / demodulation principles.

Substantiate pulse modulation techniques.

To design and implement different modulation and demodulation techniques.

YV V V V

To write and execute programs in MATLAB to implement various modulation

techniques.

V. COURSE OUTCOMES
After the completion of the course students will be able to
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Course Course Outcome statements BTL
Outcomes
CO1 Understand different analog modulation techniques &Radio L1
receiver characteristics
CO2 Analyze different analog modulation techniques L3
COo3 Design and implement different modulation and demodulation L4
techniques
CO4 Observe the performance of system by plotting graphs & Measure | L2
radio receiver characteristics.
COs5 Observe the performance of system by plotting graphs & Measure | L5
radio receiver characteristics.
VI.COURSE MAPPING WITH PO’S AND PEO’S
e P/ P|P| P P p|p | P|P
Title PO | P | PO | PO PO E|E
1 (02| 3 | 4 010 0 0 0 10 0 0 0! 0
5| 6 7 8 9 11 | 12 1 )
DSPLab | 2.2 (2.6 | 22 |24 |26 22 | 14 2 20 | 22| 22 | 26 |26 24
V_ MAPPING OF COURSE OUTCOMES WITH PEO’S AND PO’S
C
Te  |P|P|(P|P|P|P P PP | PP PP
0 0fofojojojo|oflo oo EE
1(2(3|4/5/6|7 |89 |z 99
CoO1 2 312123 2 2 1 3 3 3 3 3 3
CO2 1 2 131212 2 1 2 1 2 3 2 2 3
CO3 3 3121312 3 2 2 2 1 1 3 2 2
CO4 3 212123 2 1 3 2 2 2 2 3 2
CO5 2 312133 2 1 2 2 3 2 3 3 2

LABORATORY INSTRUCTIONS
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1. While entering the Laboratory, the students should follow the dress code. (Wear shoes and White

apron, Female Students should tie their hair back).

2. The students should bring their observation book, record, calculator, necessary stationery items and
graph sheets if any for the lab classes without which the students will not be allowed for doing the

experiment.

3. All the Equipment and components should be handled with utmost care. Any breakage or damage

will be charged.

4. If any damage or breakage is noticed, it should be reported to the concerned in charge immediately.

5. The theoretical calculations and the updated register values should be noted down in the
observation book and should be corrected by the lab in-charge on the same day of the laboratory

session.

6. Each experiment should be written in the record note book only after getting signature from the lab

in-charge in the observation notebook.

7. Record book must be submitted in the successive lab session after completion of experiment.

8. 100% attendance should be maintained for the laboratory classes.

Precautions.

1. Check the connections before giving the supply

2. Observations should be done carefully

Day to Day Observations
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WORKING PROCEDURE WITH MATLAB:
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1) Double click on Matlab icon. -> Then Matlab will be opened
2) To write the Matlab Program

Goto file menu-> New -> Script(Mfile) -> In the opened Script file write the Matlab code and save the file

with an extension of .m

Ex: “linear.m”

3)To execute Matlab Program Select the all lines in matlab program(ctrl+A) of mfile and press “F9”
to execute the matlab code

4)Entering the inputs in command window

[]If the command window is displaying the message like “enter the input sequence” then

enter the sequence with square brackets and each sample values is spaced with single space

Ex: Enter input sequence [1 2 3 4] Ifit is asking a value input write the value without brackets

Ex: “enter length of sequence 4 After entering inputs It displays the Output Graphs.

PROCEDURE TO WORK ON CODE COMPOSER STUDIO PROCEDURE FOR EXECUTING
NON REAL TIME PROGRAMS (EX: LINEAR & CIRCULAR CONVOLUTION, FFT, PSD)

Test the USB port by running DSK Port test from the start menu

Use Start[ Programs[_[lexas Instruments[_{Code Composer Studio[ {Code Composer Studio
CDSK6713 Tools[ ]DSK6713 Diagnostic Utilities

[ISelect[ [Start[ Belect DSK6713 Diagnostic Utility Icon from Desktop

[ 1Select Start Option

L Utility Program will test the board

[lAfter testing Diagnostic Status you will get PASS

To create the New Project

Project [_|[New (File Name. pjt , Eg: Vectors.pjt)

To Create a Source file
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File []New [_]Type the code (Save & give file name, Eg: sum.c).
To Add Source files to Project

Project [ JAdd files to Project [_]c/ccs studio3.1/my projects/your project name/
sum.c(select the file type as c¢/c++ source files)

To Add rts.lib file & hello.cmd:

Project [ JAdd files to Project [_ts6700.1ib

(Path:c/ccs studio3.1/cg tools/c6000/1ib/ 1ts6700.1ib)

Note: Select Object & Library in(*.0,*.1) in Type of files

Project [ JAdd files to Project [_hello.cmd

CMD file — Which is common for all non real time programs.
(Path: c/ccs studio3.1\tutorial\dsk 6713 \hello1\hello.cmd)

Note: Select Linker Command file(*.cmd) in Type of files
Compile:

To Compile: Project [ ]Compile project

To Build: Project [_]build project,

To Rebuild: Project [ Jrebuild,

Which will create the final .out executable file.(Eg. Vectors.out).

Procedure to Load and Run program:

Load the program to DSK: File [ ]Load program []Vectors. out

To Execute project: Debug [ ]Run.

1. Execution should halt at break point.

2. Now press F10. See the changes happening in the watch window.

3. Similarly go to view & select CPU registers to view the changes happening in CPU registers.

Configure the graphical window as shown below
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INPUT
x[n] = {1,2,3,4,0,0,0,0}

h[k] = {1, 2, 3, 4,0,0,0,0}

OUTPUT:
= CONVOLUTION OUTPUT  PRI=TES
Single Time =l « 0]
Graph Title CONVOLUTION OUTPUT
Start Address Y
Acquisition Buffer Size 7
Index Increment 1
Display Data Size 7
DSP Data Type 16-bit signed integer
Q-value 0
Sampling Rate (Hz) 1 s . 33_:
Flot Data From Left ta Right ]
Left-shifted Data Display  Yes
Autoscale On -16.74
7 — )
- F— I ek I 0 " 150 300 450 BO0
— — — 0. 1) Time Lin |Auto Sc

b)PROCEDURE FOR EXECUTING REAL TIME PROGRAMS
(EXCHR FILTERS,FIR FILTERS DESIGNING)

CONNECTING DSP PROCESSOR TO PC

[]Connect the dsp processor to the pc using usb cable connector.

[]Check the DSK6713 diagnostics (IF you get the “pass”then click on ok).

[IClick on ccs studio3.1 desk top icon. Then the window will be opened.

[1Go to debug click on connect (then target device will be connected to pc)

TO CREATE PROJECT

[IProject new given project name and select the family’TMS320C67XX’Then click ok

[_]File new source file write down the ‘c’program and save it with.’c” extension in current project file
[]File new dsp/bios.config file select dsk67xx click on dsk6713 and save it in current project.

[Project add files to project add source file
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[]Project add files to project add library file by following the given path

[Ulc/ces studio3. 1/cgtools/c6000/dsk6713/DSK6713.bs/file.

[]Project add files to the project .Add the configuration file.

[ INow files are generated and included in generated files . in that open the 3rd file, and copy the
header file and paste it in source file. Copy the include files named as ”dsk6713.h” and
“dsk6713_aic23.h” paste it in current project folder.

[INow compile project.(project compile)

[]Project build.

[IProject rebuild all.

[]File load program project name.pjt debug “project name .out” file click on open debug click on run
[INow apply the input sine wave to line in of dsk6713 kit.

[_1Observe the output at line out of dsk6713 by using CRO.

INTRODUCTION
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MATLAB: MATLAB is a software package for high performance numericalcomputation andvisualization
provides an interactive environment withhundreds of built in functions for technical computation, graphics

and animation .

The MATLAB name stands for Matrix Laboratory.

It also allows you to put a list of your processing requests together in a file andsave that combined list with a
name so that you can run all of those commandsin the same order at some later time. Furthermore, it allows
you to run suchlists of commands such that you pass in data and/or get data back out (i.e. thelist of
commands is like a function in most programming languages). Once yousave a function, it becomes part of
your toolbox (i.e. it now looks to you as ifit were part of the basic toolbox that you started with).

For those with computer programming backgrounds: Note that MATLAB runs asan interpretive language
(like the old BASIC). That is, it does not need to becompiled. It simply reads through each line of the
function, executes it, and thengoes on to the next line. (In practice, a form of compilation occurs when you
first run a function, so that it ca n run faster the next time you run it.)

MATLAB Windows :

MATLAB works with through three basic windows

Command Window : This is the main window .it is characterized by MATLABcommand prompt >> when
you launch the application program MATLAB putsyou in this window all commands including those for
user-written programs ,aretyped in this window at the MATLAB prompt

Graphics window: the output of all graphics commands typed in the commandwindow are flushed to the
graphics or figure window, a separate gray windowwith white background color the user can create as many
windows as the systemmemory will allow

Edit window: This is where you write edit, create and save your own programsin files called M files.
Input-output:

MATLAB supports interactive computation taking the input from the screen andflushing, the output to the
screen. In addition it can read input files and writeoutput files

Data Type: the fundamental data —type in MATLAB is the array. It encompassesseveral distinct data objects-
integers, real n umbers, matrices, charcter strings,structures and cells.There is no need to declare variables as
real or complex,

MATLAB automatically sets the variable to be real.

Dimensioning: Dimensioning is automatic in MATLAB. No dimension statementsare required for vectors or
arrays .we can find the dimensions of an existingmatrix or a vector with the size and length commands.
Where to work in MATLAB?

All programs and commands can be entered either in the a)Command window

b) As an M file using Matlab editor
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Note: Save all M files in the folder 'work' in the current directory. Otherwise youhave to locate the file during
compiling.

BASIC INSTRUCTIONS

T=10:1:10

This instruction indicates a vector T which as initial value 0 and final value 10 with an increment of 1 Therefore T = [0

12345678910]

F=20:1: 100 Therefore F=[2021222324 ......... 100]
T= 0:1/pi: 1 Therefore T= [0, 0.3183, 0.6366, 0.9549]
zeros (1, 3)

The above instruction creates a vector of one row and three columns whose values are zero

Output= [0 0 0]

Syntax: w = conv(u,v)

Description: w = conv(u,v) convolves vectors u and v. Algebraically, convolution is the same operation as
multiplying the polynomials whose coefficients are the elements of u and v.

Disp Syntax: disp(X)

Description: disp(X) displays an array, without printing the array name. If X contains a text string, the string
is displayed.Another way to display an array on the screen is to type its name, but this prints a leading "X=,"
which is not always desirable.Note that disp does not display empty arrays.

xlabel

Syntax: xlabel('string")

Description: xlabel('string') labels the x-axis of the current axes.

ylabel

Syntax : ylabel('string")

Description: ylabel('string') labels the y-axis of the current axes.

Title

Syntax :title('string')

Description: title('string') outputs the string at the top and in the center of the current axes. .grid on

Syntax :grid on Description: grid on adds major grid lines to the current axes.

FFT Discrete Fourier transform.

FFT(X) is the discrete Fourier transform (DFT) of vector X . For matrices, the FFT operation is applied to
each column. For N -D arrays, the FFT operation operates on the first non-singleton dimension.

FFT(X,N) is the N-point FFT, padded with zeros if X has less than N points and truncated if it has more.

1. Generation of random signal and plot the same as a waveform showing all

the specifications.
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Aim: To generate random signal and plot the same as a waveform showing all the specifications.
APPARATUS:PC with MATLAB Software.
PROCEDURE:
1. OPEN MATLAB
2. File >>New >>Script - Type the program in untitled window
3. File >>Save >> type filename.m in matlab workspace path

4. Debug >>Run. Wave will display at Figure dialog box.

Program:

N=input('Enter the value of N:');
n=0:N-1;

x=randn(1,N);

figure;

subplot(2,1,1);

plot(n,x);

xlabel('n');

ylabel('x');

title('Continuous Random signal');
subplot(2,1,2);

stem(n,X);

xlabel('n');

ylabel('x");

title('Discrete Random signal');

Output :--
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Continuous Random signal

Discrete Random signal

(_) T T T T T

o ? Q O

Result : Random signal and plot the same as a waveform showing all the specifications.

VIVA VOCE

1. Random variables give relationship between Random event and a real number

2. Which gives the measure of randomness of the random variable?--Variance gives the randomness of the
random variable. It is the difference between the mean square value and square of the mean.

3. Random process is a function of Random event and time
4. A random process is called as stationary in strict sense if-- Its statistics vary with shift in time origin

5. For a stationary process, autocorrelation function depends on--Time difference
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2) Finding Power and (or) Energy of a given signal

Aim : To find the Power and (or) Energy of a given signal

APPARATUS:PC with MATLAB Software.

PROCEDURE:

1. OPEN MATLAB
2. File >>New >>Script - Type the program in untitled window
3. File >>Save >> type filename.m in matlab workspace path

4. Debug >>Run. Wave will display at Figure dialog box.

Program:

%Energy of the Discrete Time Signal
n=0:1:50;

x=(1/2)."n;

figure;

subplot(2,1,1);

stem(n,X);

axis([0 250 1));

disp('The Calculated Energy E of the Signal is ");
E=sum(abs(x)."2);

disp(E);

%Power of the Discrete Time Signal
f=input(‘enter the frequency =");

fs=10*f;

nl=0:1/fs:1;

ss=sin(2*pi*f*nl);

disp('The Calculated Power p of the Signal is ');
p=sum(abs(ss).”2)/length(ss);

subplot(2,1,2);
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stem(nl,ss)

disp(p);

Output : The Calculated Energy E of the Signal is 1.3333
enter the frequency = 100

The Calculated Power p of the Signal is 0.4995

0.5 L -

0 Cr ﬂD CP (O B e N - N N . N N - NN CD
0 5 10 15 20 25

(4 )

||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||I)

R
oD

0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 1

Result: Power and (or) Energy of a given signal calculated.

VIVA VOCE
1) The signal power of the periodic rectangular pulses of height 1 and width 1, is

The signal power in the given signal using Parsevals’s relation is
P=1t/TOx2(t)dt =12/101.dt =0.5W.

2) The signal power of the signal x (t) = 2sin 2t + 4sin 4t + 6cos 4t + 2cos 2t with period 0.5 is _ Signal
power = 0.5(22 +42 + 62 + 22)
=0.54+16+36+4) =0.5(20 +40)=30 W.

3) A signal is a power signal if the signal has average power equal to _Finite

A signal is said to be a power signal if and only if the average power of the signal is finite. In other words, we can say
that a signal is a power signal if the energy of the signal is infinite, i.e., E = .

4) The energy in the time-domain representation of a signal is the same as in the frequency domain
representation normalized by 2=n

5) A periodic signal has power P/4 equal to average energy per period then rms value of signal is VP/2
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3) Convolution and correlation(auto and cross correlation)of discrete sequence
without using built in functions for convolutions and correlation operations.

Aim : To write a matlab program for Convolution and correlation(auto and cross correlation)of discrete
sequence without using built in functions for convolutions and correlation operations.

APPARATUS:PC with MATLAB Software.

PROCEDURE:

1. OPEN MATLAB
2. File >>New >>Script - Type the program in untitled window
3. File >>Save >> type filename.m in matlab workspace path

4. Debug >>Run. Wave will display at Figure dialog box.

Program:

%Linear Convolution

clc;

clear all;

close all;

disp('linear convolution program');
x=input('enter i/p x(n):');
m=length(x);
h=input('enter i/p h(n):");
n=length(h);
x=[x,zeros(1,n)];
11=0:length(x)-1;
subplot(2,2,1);

stem(11,x);

title('i/p sequence x(n)is:');
xlabel('---->n");
ylabel('---->x(n)");grid;

h=[h,zeros(1,m)];
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12=0:length(h)-1;
subplot(2,2,2);

stem(12,h);

title('i/p sequence h(n)is:');
xlabel('---->n");
ylabel('---->h(n)");grid;
disp(‘convolution of x(n) & h(n) is y(n):");
y=zeros(1,m+n-1);

for i=1:m+n-1

y()=0;

for j=1:m+n-1

if(j<i+1)
y(@)=y()+x()*h(i-j+1);
end

end

end

disp(y);

13=m+n-1;

nl=0:13-1;
subplot(2,2,[3,4]);
stem(nl,y);

title('Linear Convolution of x(n) & h(n) is :');
xlabel('---->n");
ylabel('---->y(n)");

grid;

%Circular Convolution
clc;

clear all;

Dept. of ECE, SVREC Page 21



close all;

disp('circular convolution program');
x=input('enter i/p x(n):');
m=length(x);

h=input('enter i/p sequence h(n)");
n=length(h);

subplot(2,2,1), stem(x);

title('i/p sequencce x(n)is:');
xlabel('---->n");
ylabel('---->x(n)");grid;
subplot(2,2,2), stem(h);

title('1/p sequencce h(n)is:");
xlabel('---->n");
ylabel('---->h(n)");grid;
disp('circular convolution of x(n) & h(n) is y(n):');
1f(m-n~=0)

if(m>n)

h=[h,zeros(1,m-n)];

n=m;

end

x=[x,zeros(1,n-m)];

m=n;

end

y=zeros(1,n);

y(1)=0;

a(1)=h(1);

for j=2:n

a(j)=h(n-j+2);
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end

Y%ciruclar conv

for i=1:n
y(D=y(D)+x@@)*a(i);
end

for k=2:n

y(k)=0;

% circular shift

for j=2:n
x2(j)=a(-1);

end

x2(1)=a(n);

for i=1:n

if(i<nt+1)
a(i)=x2(i);
y(k)=y(k)+x()*a(i);
end

end

end

disp(y);
subplot(2,2,[3,4]),stem(y);
title('Circular convolution of x(n) & h(n) is:");
xlabel('---->n");
ylabel('---->y(n)");
grid;

%Cross Correlation
clc;

clear all;
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close all;

z=input('Enter first sequence x(n):');
nl=length(z);

x=fliplr(z);

m=length(x);

h=input('Enter Second sequence h(n):");
n=length(h);

11=0:n1-1;

figure;

subplot(2,2,1);

stem(11,z);

title('First sequence x(n)is:");
xlabel('---->n");

ylabel('---->x(n)");

grid;

12=0:n-1;

subplot(2,2,2);

stem(12,h);

title("Second sequence h(n)is:");
xlabel('---->n");

ylabel('---->h(n)");

grid;

x=[x,zeros(1,m)];

h=[h,zeros(1,m)];

disp('Cross Correlation of x(n) & h(n) is y(n):');
y=zeros(l,m+n-1);

for i=1:m+n-1

y(i)=0;
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for j=1:m+n-1

if(j<i+1)
y(@O=y()+x(j)*h(i-j+1);

end

end

end

disp(y);

13=-(m-1):(n-1);
subplot(2,2,[3,4]);

stem(13,y);

title('Cross Correlation of x(n) & h(n) is :");
xlabel('---->n");
ylabel('---->y(n)");

grid;

%Auto Correlation

clc;

clear all;

close all;

x=input('Enter the sequence x(n):");
n=length(x);

z=fliplr(x);

m=length(z);

11=0:n-1;

figure;

subplot(2,1,1);

stem(11,x);

title('Input Sequence x(n)is:');

xlabel('---->n");
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ylabel('---->x(n)");

grid;

x=[x,zeros(1,m)];

z=[z,zeros(1,n)];

disp('Auto Correlation of x(n) & x(n) is y(n):");
y=zeros(1,m+n-1);

for i=1:m+n-1

y()=0;

for j=1:m+n-1

if(j<i+1)

y()=y()+z()*x(i-j+1);

end

end

end

disp(y);

12=-(n-1):(n-1);

subplot(2,1,2);

stem(12,y);

title("Auto Correlation of x(n) & x(n) is :');
xlabel('---->n"); ylabel('---->y(n)');

grid;

Output :

Linear convolution program

enter i/p x(n):[4 5 6 7]

enter i/p h(n):[4 7 8 9]

convolution of x(n) & h(n) is y(n):
16 48 91 146 142 110 63
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i/p sequence x(n)is: i/p sequence h(n)is:

8 10
l6) 0]

6
< =
E{ 40 = 5

i )
2
0 o O o o 0 o o o o
0 2 4 6 8 0 2 4 6 8
---->n --=->N

Linear Convolution of x(n) & h(n) is :
150

T T () d} T
100 L 4
7 >
i 50 | A
) T
0
0 1 2 3 4 5 6
J—)
Circular convolution program
enter i/p x(n):[7 4 1 2]
enter i/p sequence h(n)[7 4 1 2]
circular convolution of x(n) & h(n) is y(n):
66 60 34 36
i/p sequencce x(n)is: i/p sequencce h(n)is:
8 8
o) o)
6 6 |
g 4 g 4
2 o o2 o
0 ? 0 ?
1 2 3 4 1 2 3 4
—->n —->n
Circular convolution of x(n) & h(n) is:
80 T T T T T
60 c? -
g 40 L -
x o}
: 20 T -
0] |

Enter first sequence x(n):[7 4 1 2]

Enter Second sequence h(n):[7 4 1 2]

Cross Correlation of x(n) & h(n) is y(n):
14 15 34 70 34 15 14

Dept. of ECE, SVREC Page 27



First sequence x(n)is: Second sequence h(n)is:

8 . 8
[ D
6 , 6 |
= =
£ 4 £ 4
A A
2 D 2t D
o T o T
0 1 2 3 0 1 2 3
-——->n -——->n

Cross Correlation of x(n) & h(n) is :

80 T T T T T
60 | i
=
£ 40 | i
n
Y20 L _
(0] ff ff O
0
3 2 1 0 1 2 3
———>n

Enter the sequence x(n):[7 4 1 2]
Auto Correlation of x(n) & x(n) is y(n):
14 15 34 70 34 15 14

Input Sequence x(n)is:

8 T T T T T
()
6 L .
=
= 4+ .
A
Co2 ¥
0 1 1 ? |
0 0.5 1 1.5 2 25 3
-———>N
Auto Correlation of x(n) & x(n) is :
80 T T T T T
©
60 L .
=
= 40 .
A
: 20 L .
() j} j) ()
0
-3 -2 -1 0 1 2 3
——>n
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4. VERIFICATION OF DTFT PROPERTIES

AIM:To Verify DTDT Properties.
APPARATUS:PC with MATLAB Software.

PROCEDURE:

1. OPEN MATLAB
2. File >>New >>Script - Type the program in untitled window
3. File >>Save >> type filename.m in matlab workspace path

4. Debug >>Run. Wave will display at Figure dialog box.

PROGRAM CODE:
A) TIME SHIFTING PROPERTIES OF DTFT

clf;

w=-pi:2*pi/255:pi;

D=10;

num=[123456789];

hl=freqz(num,1,w);

h2=freqz([zeros(1,D) num],1,w);

subplot(2,2,1);

plot(w/pi,abs(hl));

grid;

title('Magnitude Spectrum of Original Sequence','FontSize',8);
xlabel("omega/\p1');

ylabel('Amplitude");

subplot(2,2,2);

plot(w/pi,abs(h2));

grid;

title('Magnitude Spectrum of Time Shifted Sequence','FontSize',8);
xlabel("omega/\p1');

ylabel('Amplitude");

subplot(2,2,3);

plot(w/pi,angle(h1));

grid;

title('Phase Spectrum of Original Sequence','FontSize',8);
xlabel("omega/\p1');

ylabel('Phase in radians');

subplot(2,2,4);

plot(w/pi,angle(h2));

grid;

title('Phase Spectrum of Time Shifted Sequence','FontSize',8);
xlabel("omega/\p1');

ylabel('Phase in radians');

WAVEFORMS:
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Magnitude Spectrum of Time Shifted Sequence

Magnitude Spectrum of Original Seguence
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i
Phase Spectrum of Time Shifted Sequence

i
Phase Spectrum of Original Sequence
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o
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B) FREQUENCY SHIFTING PROPERTIES OF DTFT

clf;

w=-pi:2*pi/255:pi;

wo=0.4*pi;

numl=[13579 1113 1517];

L=length(num1);

hl=freqz(numl,1,w);

n=0:L-1;

num2=exp(wo*i*n).*numl;

h2=freqz(num2,1,w);

subplot(2,2,1);

plot(w/pi,abs(hl));

grid;

title('Magnitude Spectrum of Original Sequence','FontSize',8);
xlabel("omega/\p1');

ylabel('Amplitude");

subplot(2,2,2);

plot(w/pi,abs(h2));

grid;

title('Magnitude Spectrum of Frequency Shifted Sequence','FontSize',8);
xlabel("omega/\p1');

ylabel('Amplitude");

subplot(2,2,3);

plot(w/pi,angle(hl));

grid;

title('Phase Spectrum of Original Sequence','FontSize',8);
xlabel("omega/\p1');

ylabel('Phase in radians');

subplot(2,2,4);

plot(w/pi,angle(h2));

grid;

title('Phase Spectrum of Frequency Shifted Sequence','FontSize',8);
xlabel("omega/\p1');

ylabel('Phase in radians');

WAVEFORMS:
Dept. of ECE, SVREC Page 31




Magnitude Spectrum of Frequency Shifted Sequence

Magnitude Spectrum of Original Seguence
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C) CONVOLUTION PROPERTY OF DTFT

clf;

w=-pi:2*pi/255:pi;

x1=[135791113 1517];

x2=[1-23-21];

y=conv(x1,x2);

hl=freqz(x1,1,w);

h2=freqz(x2,1,w);

hp=h1.*h2;

h3=freqz(y,1,w);

subplot(2,2,1);

plot(w/pi,abs(hp));

grid;

title('Product of Magnitude Spectrum','FontSize',8);
xlabel("omega/\p1');

ylabel('Amplitude");

subplot(2,2,2);

plot(w/pi,abs(h3));

grid;

title('Magnitude Spectrum of Convolved Sequence','FontSize',8);
xlabel("omega/\p1');

ylabel('Amplitude");

subplot(2,2,3);

plot(w/pi,abs(hp));

grid;

title('Sum of Phase Spectrum','FontSize',8);
xlabel("omega/\p1');

ylabel('Amplitude");

subplot(2,2,3);

plot(w/pi,angle(hl));

grid;

title('Phase Spectrum of Original Sequence','FontSize',8);
xlabel("omega/\p1');

ylabel('Phase in radians');

subplot(2,2,4);

plot(w/pi,angle(h3));

grid;

title('Phase Spectrum of Convolved Sequence','FontSize',8);
xlabel("omega/\p1');

ylabel('Phase in radians');
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WAVEFORMS:

Product of Magnitude Spectrum Magnitude Spectrum of Convolved Sequence
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D) MODULATION PROPERTY OF DTFT

clf;

w=-pi:2*pi/255:pi;

x1=[135791113 1517];

x2=[1-11-11-11-11];

y=x1.*x2;

hl=freqz(x1,1,w);

h2=freqz(x2,1,w);

h3=freqz(y,1,w);

subplot(3,1,1);

plot(w/pi,abs(hl));

grid,;

title('Magnitude Spectrum of First Sequence','FontSize',8);
xlabel("omega/\p1");

ylabel('Amplitude');

subplot(3,1,2);

plot(w/pi,abs(h2));

grid,;

title('Magnitude Spectrum of Second Sequence','FontSize',8);
xlabel("omega/\p1");

ylabel('Amplitude');

subplot(3,1,3);

plot(w/pi,abs(h3));

grid,;

title('Magnitude Spectrum of Product Sequence','FontSize',8);
xlabel("omega/\p1");

ylabel('Amplitude');

subplot(2,2,3);

plot(w/pi,angle(hl));

grid,;

title('"Phase Spectrum of Original Sequence','FontSize',8);
xlabel("omega/\p1");

ylabel('Phase in radians');

subplot(2,2,4);

plot(w/pi,angle(h3));

grid,;

title('"Phase Spectrum of Convolved Sequence','FontSize',8);
xlabel("omega/\p1");

ylabel('Phase in radians');
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WAVEFORMS:
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E) TIME REVERSAL PROPERTY OF DTFT

clf;

w=-pi:2*pi/255:pi;

num=[1 2 3 4];

I=length(num)-1;

hl=freqz(num,1,w);

h2=freqz(fliplr(num), 1,w);

h3=exp(w*1*pi).*h2;

subplot(2,2,1);

plot(w/pi,abs(hl));

grid;

title('Magnitude Spectrum of Original Sequence','FontSize',8);
xlabel("omega/\p1');

ylabel('Amplitude");

subplot(2,2,2);

plot(w/pi,abs(h3));

grid;

title('Magnitude Spectrum of Time Reversal Sequence','FontSize',8);
xlabel("omega/\p1');

ylabel('Amplitude");

subplot(2,2,3);

plot(w/pi,angle(hl));

grid;

title('Phase Spectrum of Original Sequence','FontSize',8);
xlabel("omega/\p1');

ylabel('Amplitude");

subplot(2,2,4);

plot(w/pi,angle(h3));

grid;

title('Phase Spectrum of Time Reversal Sequence','FontSize',8);
xlabel("omega/\p1');

ylabel('Phase in radians');
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WAVEFORMS:
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F) EVALUATION OF DTFT 1

clf;

w=-4*p1:8*pi/511:4%*pi;

num=[2 1];

den=[1 -0.6];

h=freqz(num,den,w);

subplot(2,2,1);

plot(w/pi,real(h));

grid;

title('Real Part of H(e” {j\omega})");
xlabel("omega/\p1');

ylabel('Amplitude");

subplot(2,2,2)

plot(w/pi,imag(h));

grid;

title('Imaginary Part of H(e" {j\omega})");
xlabel("omega/\p1');

ylabel('Amplitude");

subplot(2,2,3);

plot(w/pi,abs(h));

grid;

title('Magnitude Spectrum[H(e” {j\omega})]')
xlabel("omega/\p1');

ylabel('Amplitude");

subplot(2,2,4);

plot(w/pi,angle(h));

grid;

title('Phase Spectrum arg[H(e" {j\omega})]");
xlabel("omega/\p1');

ylabel('Phase in radians');
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WAVEFORMS:
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G) EVALUATION OF DTFT 2

clf;

N=512;

num=[0.7 -0.5 0.3 1];

den=[1 0.3 -0.5 0.7];
[h,w]=freqz(num,den,N);

subplot(2,2,1);

plot(w/pi,real(h));

grid,;

title('Real Part of H(e” {j\omega})");
xlabel("omega/\p1");

ylabel('Amplitude');

subplot(2,2,2);

plot(w/pi,imag(h));

grid,;

title('Imaginary Part of H(e" {j\omega})");
xlabel("omega/\p1');

ylabel('Amplitude');

subplot(2,2,3);

plot(w/pi,abs(h));

grid,;

title('Magnitude Spectrum [H(e” {j\omega})]");
xlabel("omega/\p1');

ylabel('Amplitude');

subplot(2,2,4);

plot(w/pi,angle(h));

grid,;

title('"Phase Spectrum arg[H(e” {j\omega})]");
xlabel("omega/\p1");

ylabel('Phase in radians');

Dept. of ECE, SVREC Page 41



WAVEFORMS
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H) EVALUATION OF DTFT 3

clf;

w=-4*pi:8*p1/511:4%pi;
num=[1357911131517];

den=1;

h=freqz(num,den,w);

subplot(2,2,1);

plot(w/pi,real(h));

grid,;

title('Real Part of H(e” {j\omega})");
xlabel("omega/\p1');

ylabel('Amplitude');

subplot(2,2,2);

plot(w/pi,imag(h));

grid,;

title('Imaginary Part of H(e" {j\omega})");
xlabel("omega/\p1");

ylabel('Amplitude');

subplot(2,2,3);

plot(w/pi,abs(h));

grid,;

title('Magnitude Spectrum [H(e” {j\omega})]");
xlabel("omega/\p1');

ylabel('Amplitude');

subplot(2,2,4);

plot(w/pi,angle(h));

grid,;

title('"Phase Spectrum arg[H(e" {j\omega})]");
xlabel("omega/\p1');

ylabel('Phase in radians');
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WAVEFORMS
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5 . Design of N point FFT algorithm

Aim: To write a program to Design of N point FFT algorithm

APPARATUS:PC with MATLAB Software.

PROCEDURE:
1. OPEN MATLAB

2. File >>New >>Script - Type the program in untitled window
3. File >>Save >> type filename.m in matlab workspace path

4. Debug >>Run. Wave will display at Figure dialog box.

Program:

clc;

clear all;

close all;

x=input('Enter the sequence:");
n=input('Enter the length of fft: ');
%compute fft

disp('Fourier transformed signal');
X=fft(x,n);

subplot(1,2,1);

stem(X);

title('i/p signal');

xlabel('n --->");

ylabel('x(n) -->");grid;
subplot(1,2,2);stem(X);

title('FFT of i/p x(n) is:');
xlabel('Real axis --->');
ylabel('Imaginary axis -->");

grid;
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Output :

Enter the sequence:[54 7 8]
Enter the length of fft: 8
Fourier transformed signal

ilp signal FFT of i/p x(n) is:
8 T T O 25 T T T
0}
7 Q i
20 | 4
6 4
15 L .
50 i
A
N oa o) . % 10t T
<
3 1 ®
E 5| 4
2 1 D
I
| - ! !
0 -5 1 | 1
1 2 3 4 0 2 4 6 8
n---> Real axis --->

Result :-- N point FFT algorithm using Matlab is designed.
VIVA VOCE

FFT algorithm is designed to perform complex operations.-The FFT algorithm is designed to perform
complex multiplications and additions, even though the input data may be real valued. The basic reason for
this is that the phase factors are complex and hence, after the first stage of the algorithm, all variables are
basically complex valued.

Decimation-in frequency FFT algorithm is used to compute H(k)-The N-point DFT of h(n), which is padded
by L-1 zeros, is denoted as H(k). This computation is performed once via the FFT and resulting N complex
numbers are stored. To be specific we assume that the decimation-in frequency FFT algorithm is used to
compute H(k). This yields H(k) in the bit-reversed order, which is the way it is stored in the memory

How many complex multiplications are need to be performed for each FFT algorithm?-The decimation of
the data sequence should be repeated again and again until the resulting sequences are reduced to one point
sequences. For N=2v, this decimation can be performed v=log2N times. Thus the total number of complex
multiplications is reduced to (N/2)log2N.
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6) Design of FIR filter using windowing technique and verify the frequenc

response of the filter

Aim: To write a matlab program for Design of FIR filter using windowing technique and verify

the frequency response of the filter.

APPARATUS:PC with MATLAB Software.

PROCEDURE:

1. OPEN MATLAB
2. File >>New >>Script - Type the program in untitled window
3. File >>Save >> type filename.m in matlab workspace path

4. Debug >>Run. Wave will display at Figure dialog box.

Program:

function FIR Filter WindowingMethod

% Design and Implementation of FIR Filter Package

% Date: 04/16/2011

% Author: Gang LIU

% Contacts: liug "at" yahoo dot cn

%

% This code is based on the some code from MATLAB Singal Processing
% Toolbox.

%

%. Example MATLAB M-file illustrating FIR filter design and evaluation.
% Finite Impulse Response filter design example

% found in the MATLAB Signal Processing Toolbox

% using the MATLAB FIR1 function (M-file)

close all;

Fs=8000; %Specify Sampling Frequency

Ts=1/Fs; %Sampling period.

Ns=512; %Nr of time samples to be plotted.

t=[0:Ts:Ts*(Ns-1)]; %Make time array that contains Ns elements

%t =[0, Ts, 2Ts, 3Ts,..., (Ns-1)Ts]

f1=500;

2=1500;

£3=2000;

f4=3000;

x1=sin(2*pi*f1*t); %create sampled sinusoids at different frequencies
x2=sin(2*pi*f2*t);

x3=sin(2*pi*f3*t);

x4=sin(2*pi*f4*t),

x=x1+x2+x3+x4; %Calculate samples for a 4-tone input signal
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%N=16; %FIR1 requires filter order (N) to be EVEN

%when gain = 1 at Fs/2.

%W=[0.4 0.6]; %Specity Bandstop filter with stop band between

%0.4*(Fs/2) and 0.6*(Fs/2)

%B=FIR1(N,W,'DC-1"); %Design FIR Filter using default (Hamming window.
disp('Please specity the filter type');

FilterType={'low','high’,'bandpass','stop'};

disp('Here is the filter option:");

disp('l: Low Pass Filter ');

disp('2: High Pass Filter');

disp('3: Band Pass Filter');

disp('4: Band Stop Filter");

disp("You only need enter number. EX. 4 means Band Stop filter')
FilterOption=input('FilterOption=");

while FilterOption ~=1 && FilterOption ~=2 && FilterOption ~=3 && FilterOption ~=4
disp("You only need enter number : 1,2,3 or 4. EX. 4 means Band Stop filter");
FilterOption=input('FilterOption=");

end

userFilterType=FilterType{FilterOption};

disp('Enter the order of the filter(Must be a positive even number, should be less than 100');
FilterOrder=input('FilterOrder=");

str=sprintf('Here is all the frequency infromation in this experiment:Fs=%d; {1=%d; f2=%d; {3=%d,
f4=%4d;' Fs,f1,2,3,f4);

disp(str);

if FilterOption==1

disp('"Enter the Edge Freq. in Hz. Note: the value should be within 0~Fs'); W=input('omega=");
elseif FilterOption==

disp('Enter the Edge Freq. in Hz. Note: the value should be within 0~Fs'); W=input('omega=");
elseif FilterOption==3

disp('Enter the Edge Freq. in Hz. Note: the value should be within 0~Fs'); W=input('omega
cutoff1="); W2=input('omega cutoff2="); W=[W W2];

elseif FilterOption==4

disp("Enter the Edge Freq. in Hz. Note: the value should be within 0~Fs'); W=input('omega
cutoff1="); W2=input('omega cutoff2="); W=[W W2];

end

%PFs, W,

W=W./(Fs/2); % [1600 2400]

N=FilterOrder;

Window_Option={'hamming','kaiser','rectwin'};

disp('Here is the Windowing option:");

disp('l: hamming');

disp('2: kaiser");

disp('3: rectwin');

WindowOption=input('WindowOption=");

while WindowOption ~=1 && WindowOption ~=2 && WindowOption ~=3
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disp("You only need enter number : 1,2,0or 3. EX. 3 means rectwin');
WindowOption=input('WindowOption=");

end

%WindowOption="rectwin';

switch Window_Option{WindowOption}

case 'hamming'

userWindow=hamming(N+1);

case 'kaiser'

userWindow=kaiser(N+1);

case 'rectwin'

userWindow=rectwin(N+1);

otherwise

disp('Wrong windowing option. EXIT");

eixt

end

%B=FIR1(N,W,'bandpass',userWindow); %Design FIR Filter using default (Hamming window.
B=firl(N,W,userFilterType,userWindow); %Design FIR Filter using default (Hamming window.
%B %Leaving off semi-colon causes contents of

%B (the FIR coefficients) to be displayed.

A=1; %FIR filters have no poles, only zeros.

figure;

zerophase(B,A); % plot zero phase figure

disp('Checking the Zero-Phase Response of the designed filter, enter any key to continue');
pause;

figure; %Create a new figure window, so previous one isn't lost.

freqz(B,A); %Plot frequency response - both amp and phase response.
disp('Checking the Freq. Response of the designed filter, enter any key to continue');
pause;

figure;

subplot(2,1,1); %Two subplots will go on this figure window.

Npts=200;

plot(t(1:Npts),x(1:Npts)) %Plot first Npts of this 4-tone input signal

title('Time Plots of Input and Output');

xlabel('time (s)');

ylabel('Input Sig');

%Now apply this filter to our 4-tone test sequence

y = filter(B,A x);

subplot(2,1,2); %Now go to bottom subplot.

plot(t(1:Npts),y(1:Npts)); %Plot first Npts of filtered signal.

xlabel('time (s)');

ylabel('Filtered Sig');

disp('Checking the Filtering Effect of the designed filter in time domain, enter any key to continue');
pause;

figure; %Create a new figure window, so previous one isn't lost.

subplot(2,1,1);
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xfftmag=(abs(fft(x,Ns))); %eCompute spectrum of input signal.
xfftmagh=xfftmag(1:length(xfftmag)/2);

%PIlot only the first half of FFT, since second half is mirror imag
%the first half represents the useful range of frequencies from

%0 to Fs/2, the Nyquist sampling limit.
f=[1:1:length(xfftmagh)]*Fs/Ns; %Make freq array that varies from
%0 Hz to Fs/2 Hz.

plot(f,xfftmagh); %Plot frequency spectrum of input signal
title('Input and Output Spectra');

xlabel('freq (Hz)');

ylabel('Input Spectrum');

subplot(2,1,2);

yfftmag=(abs(fft(y,Ns)));
yfftmagh=yfftmag(1:length(yfftmag)/2);

%Plot only the first half of FFT, since second half is mirror image
%the first half represents the useful range of frequencies from

%0 to Fs/2, the Nyquist sampling limit.

plot(f,yfftmagh); %Plot frequency spectrum of input signal
xlabel('freq (Hz)');

ylabel('Filtered Signal Spectrum');

OUTPUT :

Please specify the filter type

Here is the filter option:

1: Low Pass Filter

2: High Pass Filter

3: Band Pass Filter

4: Band Stop Filter

You only need enter number. EX. 4 means Band Stop filter

FilterOption=1

Enter the order of the filter(Must be a positive even number, should be less than 100

FilterOrder=6

Here is all the frequency infromation in this experiment:Fs=8000; {1=500; 2=1500; f3=2000; {4=3000;
Enter the Edge Freq. in Hz. Note: the value should be within 0~Fs

omega=1000
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Here is the Windowing option:

1:  hamming

2: kaiser

3: rectwin

WindowOption=1

Checking the Zero-Phase Response of the designed filter, enter any key to continue
Checking the Freq. Response of the designed filter, enter any key to continue

Checking the Filtering Effect of the designed filter in time domain, enter any key to continue

0.8

0.6

0.4

Amplitude

0.2

-0.2

Zero-phase response

0.1

0.2 0.3 0.4

Normalized Frequency (

0.5

0.6 0.7
N rad/sample)

Dept. of ECE, SVREC

Page 51



T
)
A=)
o 50 L
kel
=2
c
()]
©
=
-100 1 1 1 1 1 1 1 1 1
0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 1
Normalized Frequency ( < rad/sample)
0 T T T T T T T T T
% 200 4
(0]
o
[}
(0]
S
° -400 | 4
[2]
]
c
o
-600 1 1 1 1 1 1 1 1 1
0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 1
Normalized Frequency ( < rad/sample)
Time Plots of Input and Output
4 T T T T
2
(o))
mn 0
5
Q.
[
£ |
-4 1 1 1 1
0 0.005 0.01 0.015 0.02 0.025
time (s)
2
T T T T
1 4
2
%)
el
o
o 0 4
=
-1 1 1 | |
0.005 0.01 0.015 0.02 0.025
time (s)

Dept. of ECE, SVREC

Page 52



Input and Output Spectra
300 . .
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Input Spectrum
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Result:-- FIR Filter using Matlab is designed.
VIVA VOCE

What are the desirable characteristics of the frequency response of window function?
Advantages:

a) FIR filters have exact linear phase.

b) FIR filters are always stable.

c) FIR filters can be realized in both recursive and non recursive structure.

d) Filters with any arbitrary magnitude response can be tackled using FIR sequency.
Disadvantages:

a) For the same filter specifications the order of FIR filter design can be as high as 5 to n10
times that of IIR design.

b) Large storage requirements needed.
¢) Powerful computational facilities required for the implementation.

The Optimum Equiripple design Criterion is used for designing FIR Filters with Equal level
filteration throughout the Design.

FIR Filter is always stable.

FIR Filter with exactly linear phase can easily be designed.
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7) Design of IIR filter using anyof the available methods and verify the frequency
response of the filter

Aim: To write a matlab program for design of IIR filter using anyof the available methods and
verify the frequency response of the filter.

APPARATUS:PC with MATLAB Software.
PROCEDURE:
1. OPEN MATLAB
2. File >>New >>Script - Type the program in untitled window
3. File >>Save >> type filename.m in matlab workspace path

4. Debug >>Run. Wave will display at Figure dialog box.

Program:

% IIR FILTERS LPF & HPF USING MATLAB
clc;

clear all;

close all;

disp(‘enter the IIR filter design specifications');
rp=input(‘enter the passband ripple");
rs=input('enter the stopband ripple');
wp=input('enter the passband freq');
ws=input(‘enter the stopband freq");
fs=input(‘enter the sampling freq');
w1=2*wp/fs;w2=2*ws/fs;
[n,wn]=buttord(w1,w2,rp,rs,'s");

% IIR FILTERS LPF & HPF USING MATLAB
clc;

clear all;

close all;

disp(‘enter the IIR filter design specifications');
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rp=input('enter the passband ripple');
rs=input('enter the stopband ripple');
wp=input('enter the passband freq');
ws=input('enter the stopband freq');
fs=input('enter the sampling freq");
w1=2*wp/fs;w2=2*ws/fs;
[n,wn]=buttord(w1,w2,rp,rs,'s");
c=input(‘enter choice of filter 1. LPF 2. HPF \n');
if(c==1)

disp('Frequency response of IIR LPF is:");
[b,a]=butter(n,wn,'low",'s");

end

if(c==2)

disp('Frequency response of IR HPF is:");
[b,a]=butter(n,wn,'high','s");

end

w=0:.01:pi;

[h,om]=freqs(b,a,w);
m=20*log10(abs(h));

an=angle(h);
figure,subplot(2,1,1);plot(om/pi,m);
title("'magnitude response of IIR filter is:");
xlabel('(a) Normalized freq. -->");
ylabel('Gain in dB-->');
subplot(2,1,2);plot(om/pi,an);

title('phase response of IR filter is:');
xlabel('(b) Normalized freq. -->");

ylabel('Phase in radians-->');
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Output :--

enter

enter

enter

enter

enter

enter

enter

the

the

the

the

the

the

IIR filter design specifications
passband ripple.b5
stopband ripple.8
passband freql000
stopband freq2000

sampling freg3000

choice of filter 1. LPF 2. HPF

Frequency response of IIR LPF is:

Gain in dB-->

Phase in radians-->

Result:-- IIR filters using matlab is designed.

magnitude response of IIR filter is:

-2
-3

-4 1 1 1 1 1 1 1 1 1

0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9

(a) Normalized freq. -->
phase response of IIR filter is:

0 T T T T T T T T T
-0.5

-1 1 1 1 1 1 1 1 1 1

0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9

(b) Normalized freq. -->
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8) Design of analog filters
Aim:To writa a matlab program for design of analog filters

APPARATUS:PC with MATLAB Software.

PROCEDURE:

1. OPEN MATLAB
2. File >>New >>Script - Type the program in untitled window
3. File >>Save >> type filename.m in matlab workspace path

4. Debug >>Run. Wave will display at Figure dialog box.

Program:

clc;

clear all;

close all;

disp('Enter the Analog filter design specifications');
N=input('Enter the order of the filter");
c=input('Enter the choice of filter 1. LPF 2. HPF 3.BPF 4.BSF \n ");
if(c==1)

disp('Frequency response of Analog LPF is:');
Cf=100;

[b,a]=butter(N,Cf,'S");

freqs(b,a);

end

if(c==2)

disp('Frequency response of Analog HPF is:');
Cf=100;

[b,a]=butter(N,Cf,'HIGH",'S");

freqs(b,a);

end

if(c==3)
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disp('Frequency response of Analog BPF is:");
Cf1=[10 100];

[b,a]=butter(N,Cf1,'S");

freqs(b,a);
end
if(c==4)

disp('Frequency response of Analog BPF is:");
Cf1=[10 100];
[b,a]=butter(N,Cf1,'STOP",'S");

freqs(b,a);

end

OUTPUT :

Enter the Analog filter design specifications

Enter the order of the filtero6

Enter the choice of filter 1. LPF 2. HPF 3.BPF 4.BSF

2

Frequency response of Analog HPF is:

10
10 -10 _ﬁ
[}
o
=
5
-20
© 10 -
=
10 30 \ | I L
10 2 10 " 10° 101 10 10
Frequency (rad/s)
200 T T T T
100 | d
)
3
> o L 1
(5]
=
(]
& 100 L d
=
o
-200 1 1 L 1
10 2 10 " 10° 10 ° 10

Frequency (rad/s)

Result :-- Analog filters using Matlab is designed.

103
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CC STUDIO PROGRAMS
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TMS320C6x DIGITAL SIGNAL PROCESSOR
INTRODUCTION

The TMS320C6713 (C6713) is based on the VLIW architecture, which is very well suited for numerically
intensive algorithms. The internal program memory is structured so that a total of eight instructions can be

fetched every cycle. For example, with a clock rate of 225MHz, the C6713 is capable of fetching eight 32-

bit instructions every 1/(225 MHz) or 4.44 ns. Features of the C6713 include 264 kB of internal memory
(8kB as L1P and L1D Cache and 256kB as L2 memory shared between program and data space), eight
functional or execution units composed of six arithmetic-logic units (ALUs) and two multiplier units, a 32-

bit address bus to address 4 GB (gigabytes), and two sets of 32-bit general-purpose registers.

The C67xx (such as the C6701, C6711, and C6713) belong to the family of the C6x floating-point processors,
whereas the C62xx and C64xx belong to the family of the C6x fixed-point processors. The C6713 is capable
of both fixed- and floatingpoint processing.

An application-specific integrated circuit (ASIC) has a DSP core with customized circuitry for a specific
application. A C6x processor can be used as a standard general-purpose DSp programmed for a specific

application. Specific purpose digital signal processors are the modem, echo canceler, and others. A

fixed-point processor is better for devices that use batteries, such as cellular phones, since it uses less power
than does an equivalent floating-point processor. The fixed-point processors, C1x, C2x, and C5x, are 16-bit
processors with limited dynamic range and precision. The C6x fixed-point processor is a 32- bit processor
with improved dynamic range and precision. In a fixed-point processor, it is necessary to scale the data.
Overflow, which occurs when an operation such as the addition of two numbers produces a result with more

bits than can fit within a processor’s register, becomes a concern.

A floating-point processor is generally more expensive since it has more “real estate” or is a larger chip
because of additional circuitry necessary to handle integer as well as floating-point arithmetic. Several

factors, such as cost, power consumption, and speed, come into play when choosing a specific DSp.

The Co6x processors are particularly useful for applications requiring intensive computations. Family
members of the C6x include both fixed-point (e.g., C62x, C64x) and floating-point (e.g., C67x) processors.

Other DSp’s are also available from companies such as Motorola and Analog Devices.
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CET13 Digital Signal Processor

L1P Cache

Direct Mapped
4 KBytes

C6&Tx DSP Core

Instruction Fetch Control
- - Reqisters
Instruction Dispatch
- Control
Instruction Decode Logic
Data Fath B Test
|A Register File | |B Register Fi|B| In—Circuit
KR B B Emulation
Flr ¥ L L
[D2|m2[s2[12] | Interrupt
3 Control

Boot
Configuration

EMIF
16
HPI
m .
% McASP (2)
=1
— = MCBSP (2) | C'DanEd
E Controller
a 12C (2) - Channels
T
|
Interrupt
Selectgr =
FPower Down
Logic
PLL
Controller

L1D Cache

Q—Wadeel Associative

K Eytes

Figure : Functional block diagram of TMS320C6713

The TMS320C6713 onboard the DSK is a floating-point processor based on the

VLIW architecture [6—10]. Internal memory includes a two-level cache

architecture with 4 kB of level 1 program cache (L1P), 4 kB of level 1 data cache

(L1D), and 256 kB of level 2 memory shared between program and data space.

It has a glueless (direct) interface to both synchronous memories (SDRAM and

SBSRAM) and asynchronous memories (SRAM and EPROM). Synchronous

memory requires clocking but provides a compromise between static SRAM and

dynamic DRAM, with SRAM being faster but more expensive than DRAM. On-chip

peripherals include two McBSPs, two timers, a host port interface (HPI), and a
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32-bit EMIF. It requires 3.3 V for I/O and 1.26 V for the core (internal). Internal
buses include a 32-bit program address bus, a 256-bit program data bus to
accommodate eight 32-bit instructions, two 32-bit data address buses, two 64-
bit data buses, and two 64-bit store data buses.With a 32-bit address bus, the
total memory space is 232 = 4GB, including four external memory spaces: CEO,
CEl, CE2, and CE3. Figure shows a functional block diagram of the C6713
processor included with CCS.

TMS320C6X- PROCEDURE FOR USING C60 DEBUGGER

Stepl: Open > 6177 Diagnostic > start > Stop > Close

671 3DSK Diagnostics W=l
G srsral I Advanced l
. . Aot
Dwerall Diagnostic Test Diagnostic Status ﬁ
&  USB Diagnoshcs
& Ermulation Diaghostics LSk aio
& DSP Diaghostics P
& E M Component | Walue I
wternal Memory UIkility R evision 112 E@
i@ Flazh Diagrostics Board Wersion 2
& Codec Diagnostics CPLD Wersion 2 Rezet DSE
@ LED Diagnostics
2 Dip Swt Diagnostics save As
Help |

Diagnostic Fezults

Starting diagnoztic tezt suite.

--* Runming USE diagnostics.

--» Running emulator diagnostics.

--» Runmng DSP diaagnoshics.

-+ Running esternal memory diaghostics

Step 2: Project > New > Project Name - Target > TMS320C67XX
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File Edit Wiew Project Debug GEL ©Option Profile Tools DSP/BIOS ‘Window Help

P

S E| b BB Sl AR RS EE 4S8
| | Hleaas 08(2% | 64|

BHe oPEEHEL

) Files

™ (2 GEL files
[0 Projects

Project Creation

Project Name: |smawave

Lacation: |C “Dacuments and Settingsh\Administra J

Froject Type: IExecutable [.out)

Target TMS320CET-%
TMSI20CE240
T

Step 3: Libraries > Add Files to Project > My Project > C600 > CG Tools >

Library - rts6700.lib

# JC6713 DSKSCPU_1 - C621x - Code Composer Studio - Mot Connected
File Edit Wiew Project Debug GEL Option Profile Tools DSPJEIOS ‘window Help

B E R B A nf?ﬁ;?‘EE‘/‘%%’§|.~|
[Sewavepi ~I[oebum Cllesst| o8> 88

Hle oBsEHEL

Ei ! Files

™ [0 SEL Files
=424 Projects
i =125 sinewave.pjt (Debu
! L pependent Project
- (L1 bocuments
o (£ DSPIBIOS Config
|1l Generated Files
3 Include:
L Libraries
-1 source

Add Files to Project
Lok in: | (=3 lib ~| = = cF BE-

Fastmatha7x rts&400 rts6700e
Fastmathe7xe rts6400_sh res6700e_sh
rts6200 rtsé400e

EELTIRLYER

rts6200_sh rts6400e_sh
rts6200e o
rts6z00e_eh

File name:  [ns6700 Open |
Files of type: | Object and Library Files (0”1 -~ Cancel
Help
2

Step 4: File > New > Source File > Write Program in window
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% JC6713 DSK/CPU_1 - C621x - Code Composer Studio - Mot Connected

Edit  ‘iew Project Debug GEL

Option  Profile  Tools DSPBIOS  Window Help

BE G BR& o

e = A N

j|ﬁﬂ“ﬁ‘h%?:}|§k’?|£§§

I sinewave. pit

L” Debug

Slle@Es L0528 2|

Hoe sEBEEHEL

EEEEIRNEY

= a Projects

Elﬁ sinewave.pjt {(Debu
-[Z1] Dependent Project
D Documents
-[Z7] DSP{BIOS Config
-[]) Generated Files
-1 Include
(21 Libraries

1. Untitled1 *

#include<dstdia.h>

#include<math.h>
float a[l00];
maini )

int 1:

for{i=0:i<100:1i++)

1

afi]=sin(2*3. 14*S*i/100);
printf{"%f ~n".,a[i]):

}

/

Edit

Vieww  Project  Debug  GEL

Option  Profile Toaols DSPIBIOS  window Help

| BB o

BRI L AT O I e A

=
=

I sinewave.pjt

;”Debug

Fler D EmEEHEL

™
>

EREIELY

@ Files
[#-[L] GEL files
=1 =3 Projects

EI@ sinewave.pjt {Debu

-|_] Dependent Project

-[Z1) Documents
[_1 DSPJEIOS Config
-2 Generated Files
-2 Include
-[Z7 Libraries
-[C1 source

{_ Untitled1 * |E3
#include<stdio.h> =
#include<math h> —
float a[1007:
maini( )

{
int i:
for(i=0:i<100zi4++)
i
al[i]=sin(Z=3. 14=5*i-100) ;
printf ("%f ~n".a[i]):
1
:
Save in: IE} sinaa LI = o ER-
File name: |sinawave.d Save I
Save aslyps: | C/C++ Source files [%.67) - Cancel |
Help |
o |
« a
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lib > confi.c

Step 6: Source > Add Files to project > CStudio >

# JC6713 DSKS/CPU_1 - C621x - Code Composer Studio - Not Connected

File Edit Wiews Projectk Debug GEL  Option Profile Tools DSPYBIOS  Window  Help

S Z M| =)o o~

&R TS| S EE( 4% %A |

Isinewavepit L”Dehug Lll @ ] | R} ﬁ|5\% | . & |

Fle 0EPBEEHE-S

™ g Files {1 sinawave.c

w g EEL_F'ITS #include<dstdia.h> B

m A Frojects . #include<math h>

{r =l @ sinewave.pjt {Debu float a[1007;

™ [ Dependent Project main () -

= (Z1 Documents

L |Z DSRIBIOS Config int i:

— L0 Generated Files In. .
- : 1 Tnclude E‘or(l—ﬂ,l(lDD,1++)
* g cbraries a[i]=sin(Z%3.14%5%ir 100);
. sapeliesl . printf ("%f ~n".,a[1]):

2 e Configurationl

g ¥ Add Files to Project
Lok ir: | 3 lib RN el ==

Configurationlcfg_c

=

&
File name: IEnnfiguralinrﬂ cfo_c m
Files of type: IC Source Files [*.c%ccc) ;I Cancel |

Help |
e |
P [

Step 7: Source > Add Files to Project > CStudio > C600 -> Tutorial >

Dsk6713 = hellol >

link cmd - hello.cmd
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# JC6713 DSK/CPU_

C621x - Code Composer Studio - Mot Connected

File Edit “iew Project Debug GEL  Option

Prafile  Tools DSP/BIOS ‘Window Help

I

I T

§¥?|u§§+§§ nﬁ%ﬁﬁ%|§§|/‘%%’§|"|

Islnewa\-’e.p|t L”Debug L” @ ILI | @ ﬁls\% | . & |

Fler B EBREEHEA

™ § Files { sinawave.c

w :g oL fles #include<stdio.h> =

g = e : #include<math .h>

i = @ sinewave.pjt (Debu float a[i00]:

™ [Z2] Dependent Project main() -

= (23 Documents I

o |21 DSPYBIOS Config int i:
0 (23 Generated Files P L

13 23 Include for(1—0,1<100,1++)

* g;‘bﬂ:s a[i]=sin(Z*3.1l4%x5%i,100);

= b Configurationl [})I‘lntf ("%=f ~n".alil)s

&. ¥ Add Files to Project

= —
—_ Lok in: |23 hello1 | -~ =5 EE-

[C)Debug

IChello,cs_

@ Colguratlonlcfg

3

«|

File name: Ihelln Open I
Files of type: | Linker Cammand File [*.cmd;™ Icf) ~| Cancel |

Help |4

Step 8: Project > Compile File

# /C6713 DSKICPU_1 - C671x - Code Composer Studio

File Edit ‘“iew Project Debug GEL Option Profile Tools DSP/EIOS  window  Help

I

iz o
= e

o [ T

ELIEE HEE| 4% %4 6|

sinawave.c X
=

Isinewavepit L”Dehug L” @ | <M | 5\ % | . & |
Bl 0 EBEHEL

™ § Files 1

w :g S:]ifz #includedstdio.h>

{1 =l-g5 sinewave.pjt (Debu #includsdmath . h>

™ L1 Dependent Project

= D Documents

¥ (21 DSREIOS Config
— 2] senerated Files

- [ Include

{l} 29 Libraries

&

=

=&

iz

&

float a[100]:

maini )

i

int

for( | ]
) 00004EZ4 OFFFBE112 ~

afi] DO004E28 01A7102A T

prin 00004E2C 01800064

! = N0n4E30 00004000

¥ 00004E34 00000000 |

00004E358 00000000
00004E3C 00000000
O0004E40 00000012
O0004E44 00006000
nNANarF4as NOnnnniz L)

Step 9: Project > Build all
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LIRS " T G T | N2 iz [EE s A%
W Use External Makefile... SN PR &L

| Export to Msksfie.
Ed & @ AddFilestoProject...
Iif Save
™ | [FFies | Close
5 :'g Source Control cluded<stdio.h>
{7 - cludedmath . h>
& Compile File Ctrl F7 At a[100]:
Build F7 ni)

p |
2

op B s
| Build Clean N1i=0:i<100;:1++)

= 1155

Configurations... l=sin(2#*3.14=5S=i,100);
| Buid Options... ntf("%f ~n".a[i]):
T File Specific Options. ..

Project Dependencies. ..

Show Project Dependencies

Show File Dependencies

Scan All File Dependencies

Recent Project Files »

B#08 wuns < I

A

ol =

v

‘| CGEL StartUp Complete.
Use -heap option to change the default si

Build Complete.
0 Errors. 2 Warnings. 0 Remarks. AI

Step 10: File > Load Program > Debug > Output File

# fC6713 DSKICPU C671x - Code Composer Stu

File Edit W¥iew Project Debug GEL Option Profie Tools DSPJBIOS  Window Help

EEEEIEEEEEEEE d\ﬁa-&%%*:ﬂgw\ug |§E\A%%&»|o"‘
[Sinewave pi ~1[Debug =R T

= =2 EEE A
™ Files 1. sinawave.c
w L i #include<stdia-h>
(= £ Profects
s - , #include<math .h>
r =125 sinewave.pjt (Debu
float a[100]:
™ (I3 Dependent Project in()
- £ Documents v
¥ (L DSP/BIOS Canfia int i:
— L1 Generated Files i .
=1 1 Teehado for(l—ﬂ,l(lﬂﬂ,lfi»)
I =43 Libraries a[i]=sin(Z=3. ld=xS=i 1007 ;
d res6700.lb printf("%f ~n".a[i]):
& = 4E3 Seurce = - B
: sinawvwave.c ——
; hello.cmd } Load Program 2]
R Look in: [ Debug | - cF E-
==l
&1
File name: [sinewane Open |
Files of bwpe: [ *.out ] Cancel
Help
—
= I | =
_~| |[GEL StartUp Completse.
Use -heop option to change the default si
Build Complete.
0 Errors. 2 Warnings. 0 Remarks. j
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Step 11: Debug > Run

File:

Edit View Project

GEL  Option  Profile  Tools

DSPBICS  Window  Help

= E | % Ea g reskenns ﬁ‘a*ﬁah%-‘;}gléwﬂa&é*;é n§§ﬁ§§|EE|/‘%%§-|.‘|
vobe Points...
— step Inta F11 h | PR
Step Cwer F10
B O %
Step Out Shift+F11
™ Files i i
_{_}‘ D SEL Files Ha!t shift+FS
5153 Profects Animate AlE+FS
f4nd 225% sinewa  FunFres Chrl+FS
—{', Run to Cursor Chrl+F10
Set PC to Cursor Chrl+5hift+F10
o Muliple Gperation. ..
- Assembly/Source Stepping +]
“ Reset CPU Chrl+F: Exi 1007
2: Restart Chrl+Shift+F5 [ i ] ) :
Go Main Chrl+M
ﬁ: Resst Emulator Ctrl+Shift+R
% Disconnect Alt+C
B Restore Debug State
=
I Enable Thread Level Debugging. ..
Real-time Made
= Enable Rude Real-time Mods
&1 w Flush Fipeline on Halt
< i} | =
|| I/ I
—0.3933866 | |[CEL StartUp Complete.
-0.955670
-0.818001
-0.600340
-0.323974

Step 12: Veiw >

Graph > Time/Frequency
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File

Edit  wiew Project GEL

Option  Profile  Tools DSPIBIOS  Window  Help

& L) | 4 Em g Breskpoints. 5 R e T G 0 | S N2 | oE

Probe Points. ..

.

(HEE | 4% % 4o |

=

=

warve. pit step nto

Step Ower
lge | & %ﬂ Step Cut

™

o | P S
Fio
Shift+F11

&

Files Halt ShiFt-+FS
(22 GEL files = e
5159 Projects Animate AlE+FS
=] é sinewd Run Free Crrl4+FS
Run to Cursor Chrl+F10
Set PC to Cursor Chrl+Shift+F10
Multiple Cperation. ..
Assembly/Source Stepping [
Reset CPU Crl+R Exi 100 ) .
Restart Ctrl+Shift+FS [1]):
Go Main Cerl+r
Reset Emulator Crrl+Shife+R.
Disconnect Alt+C

Restore Debug State

Enable Thread Level Debugging. ..

Real-tims Mods
= Erable Ruds Resl-time Maods
&1 w Flush Pipeline on Halt
) &
Tof
-0.999866 | |[FEL StartUp Complete.
-0.955670
-0.818001
-0.600340
-0.323974

Step 13: Start Address ‘@’ and DSP data type- 32 bit floating point

C671x - Code Composer Stu

File Edit View Project Debug GEL  Option  Profile Tools DSP/BIOS window Help
B = Fll & A b S| (EE| 4% %% o |
[Snewave pt ~|[oetus Clle@Eas| oA >k 6]

Fle | oEmEHEL

™ Files 1. sinawave.c
w Egs:;:: #includedstdio.h>
P -~ . #include<math.h>
r =i-£zj sinewave.pit (Debu .
: " float a[100]:
™ [ Dependent Project main i)
= (L3 Documents
¥ L1 DSPBIOS Config int i:
— 0 Generated Files o R =
e 3 thelude for(1—D,1<1DD,1++) =
o 423 Libraries Sl[i]-sin(2%3.14%5%i 100 : Display Typs Single Time
o rsa700.0b IMEELNEE it . . - Graph Title Graphical Display
& rce printf (" n".alil): Start fddress a
g sinawave.c 3 Acquisition Buffer Size 128
: hello.cmd Index Increment 1
= Display Diata Size 200
e DSP Data Type 32-bit floating point
Sampling Rate [Hz) 1
Plaot Data From Left to Right
Left-shifted D ata Display Yes
= Autoscale On
DC Walue a
&7 Aues Display on
= Time Display Urit s
Status Bar Display On
Data Plot Style Line
Grid Style Zero Line
Cursor Mode Drata Cursor
Cancel | Help |
=1 i | =
0]
0.322466 ;I GEL StartlUp Complete.
0.014333
-0.295201
-0.575869
-0.800222 s
-0.946324 -]

Step 14: We will get th required output ...........!1111

Dept. of ECE, SVREC Page 69



1) GENARATION OF RANDOM AND SQUARE SIGNAL
1.Program --

#include<stdio.h>

#include<math.h>

#define PI 3.14

#define PTS 128

float x[PTS];

float y[PTS];

float z[PTS];

float n[PTS];

void main()
{
inti,j;

for(i=0;i<PTS; i++)

{
x[i] = sin(2*PI*i*20/128.0);
printf("%fA\n",x[i]);
y[i]1=0.0;
n[i]=x[i] + rand() * 10 ;

¥

¥
2. Program--

#include <stdio.h>

#define amp 1 // defined amplitude
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int y[50]; // no. of points to be stored in output variable 'y’

inti;
void main()
{
for(i=0;i<25;i++)
{
y[i]=amp;
printf("%d\n",y[i]);
b

for(i=25;i<50;i++)

{
yli]=-amp;
printf("%d\n",y[i]);
}
¥
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2 Finding energy and power of a signal.

1. Program-- Energy of a signal
#include<stdio.h>
int main()
{
int num,i,j,x[32];
long int sum=0;
printf("\nEnter the humber of samples: ");
scanf("%d",&num);
printf("\nEnter samples: ");
for(j=0;j<num;j++)
scanf("%d",&x[j]);
for(i=0;i<=num;i++)
{

sum+=x[i]*x[i];

b

printf("\n the energy of above samples is\n %d",sum);

return O;
b
2. Program--Power of a signal
#include<stdio.h>
int main(){
int num,i,j,x[32];
float numil;
long int sum=0;
printf("\nEnter the number of samples: ")

scanf("%d",&num);
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printf("\nEnter samples: ");

for(j=0;j<num;j++)
scanf("%d",&x[j]);

for(i=0;i<=num;i++)

{

sum+=x[i]*x[i];

b

num=num%*2;

num++;

numl = sum / (float) num;

printf("\n the Average power of above samples is\n %.2f",num1);

return O;

by
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3 ) Convolution and correlation(auto and cross correlation)of discrete
sequence without using built in functions for convolutions and
correlation operations.
Program:

[*linear convolution*/
#include<stdio.h>

int x[15],h[15],y[15];

main()

{

inti,j,m,n;

printf("\n enter value for m");
scanf("%d",&m);

printf("\n enter value for n");
scanf("%d",&n);

printf("Enter values for i/p x(n):\n");
for(i=0;i<m;i++)

scanf("%d",&x[i]);

printf("Enter Values for i/p h(n) \n");
for(i=0;i<n; i++)

scanf("%d",&h[i]);

/l padding of zeros
for(i=m;i<=m+n-1;i++)

x[i]=0;

for(i=n;i<=m+n-1;i++)

h[i]=0;

/* convolution operation */
for(i=0;i<m+n-1;i++)

{

y[il=0;
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for(j=0;j<=i;j++)

{

y[i=y[il+(xO1*h(i-j]);

1}

/[displaying the o/p

for(i=0;i<m+n-1;i++)

printf("\n The Value of output y[%d]=%d",i,y[i]);

}

/* program to implement circular convolution */
#include<stdio.h>

int m,n,x[30],h[30],y[301,i,j, k,x2[30],a[30];

void main()

{

printf(" Enter the length of the first sequence\n");
scanf("%d",&m);

printf(" Enter the length of the second sequence\n");
scanf("%d",&n);

printf(" Enter the first sequence\n");

for(i=0;i<m;i++)

scanf("%d",&x[i]);

printf(" Enter the second sequence\n");
for(j=0;j<n;j++)

scanf("%d",&h[j]);

if(m-n!=0) /*If length of both sequences are not equal*/

{

if(m>n) /* Pad the smaller sequence with zero*/

{
for(i=n;i<m;i++)

h[i]=0:
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for(i=m;i<n;i++)

x[i]=0;

m=n;

}

y[0]=0;

a[0]=h[0];
for(j=1;j<n;j++) /*folding h(n) to h(-n)*/
afjl=h[n-jl;

[*Circular convolution®/
for(i=0;i<n;i++)
y[0]+=x[i]"al[i];
for(k=1;k<n;k++)

{

y[k]=0;

[*circular shift*/
for(j=1;j<n;j++)
x2[j]=af-11;
x2[0]=a[n-1];
for(i=0;i<n;i++)

{

a[il=x2[i];
yIK]+=x[]*x2[i];

}

}

[*displaying the result*/
printf(" The circular convolution is\n");

for(i=0;i<n;i++)
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printf("%d \t",y[i]);

}

[*cross correlation®/
#include<stdio.h>
#include<math.h>

int y[10];

main()

{i

nt i,j;

int x[15]={1,2,3,4,0,0,0,0,0,0,0,0,0,0,0};
int h[15]={4,3,2,1,0,0,0,0,0,0,0,0,0,0,0};
int n=4;
for(i=-(n-1);i<=(n-1);i++)

{

y[i1=0;

for(j=0;j<=4;j++)

y[il+= x[] * h{-i];

M

or(i=-(n-1);i<n;i++)
printf("%d\n",y[i]);

}

[*auto correlation®/
#include<stdio.h>
#include<math.h>

int y[10];

main()

{
int i,jk;
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int x[15]={0,0,0,0,0,1,1,1,1,1,0,0,0,0,0};

int n=15;

k=n-1;
for(i=-(n-1);i<=(n-1);i++)
{

y[i+k]=0;
for(j=0;j<=5;j++)
y[i+K]+=x[j+K] * x[i+j+K];
M

or(i=-(n-1);i<n;i++)
printf("%d\n" y[i+k]);

}
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4 ) DTFT of a given signal

Program--

#include<stdio.h>

#include<math.h>

int N,k,n,i;

float pi=3.1416,sumre=0, sumim=0,out_real[8]={0.0}, out_imag[8]={0.0};

int x[32];

void main(void)

{

printf(" enter the length of the sequence\n");
scanf("%d",&N);
printf(" enter the sequence\n");
for(i=0;i<N;i++)
scanf("%d",&x[i]);

for(k=0;k<N;k++)

{

sumre=0;

sumim=0;

for(n=0;n<N;n++)

{

sumre=sumre+x[n]* cos(2*pi*k*n/N);

sumim=sumim-x[n]* sin(2*pi*k*n/N);

b

out_real[k]=sumre;

out_imag[k]=sumim;

printf("X([%d])=\t%f\t+\t%fi\n", k,out_real[k],out_imag[k]);

b

b
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5) N — point FFT algorithm
Program--
#include<stdio.h>

#include<math.h>

#define PI 3.14

typedef struct
{
float real,imag;
Ycom;
void main()
{
com xx[8],x[8],temp[8],temp1[8],y[8],a[8],b[8],w[4];
int i,j=0;//loop counter variables
printf("\nEnter 8 input samples==");

for(i=0;i<8;i++)

scanf("%f",&xx[i].real);

j=0;

for(i=0;i<8;i=i+2)

{
x[j].real=xx[i].real;
x[j+1].real=xx[i+4].real;
if(i==2)

i=-1;

Dept. of ECE, SVREC Page 80



j=j+2;

b
for(i=0;i<4;i++)
{
wli].real=cos(2*PI*i/8);
w[i].imag=-sin(2*PI*i/8);
¥

for(i=0;i<8;i=i+2)

{
templi].real=x[i].real+x[i+1].real;
temp[i].imag=x[i].imag+x[i+1].imag;
templ[i+1].real=x[i].real-x[i+1].real;
templ[i+1].imag=x[i].imag-x[i+1].imag;

b

for(i=2;i<8;i=3%*i)

{
ali].real=temp[i].real*w[0].real-templ[i].imag*w[0].imag;
ali].imag=templi].real*w[0].imag+templi].imag*w[0].real;
ali+1].real=temp[i+1].real*w[2].real-temp[i+1].imag*w[2].imag;
ali+1].imag=temp[i+1].real*w[2].imag+templ[i+1].imag*w[2].real;
templ[i].real=ali].real;
templi].imag=a[i].imag;
temp[i+1].real=a[i+1].real;

temp[i+1].imag=a[i+1].imag;
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for(i=0;i<6;i++)

{
templ[i].real=templi].real+temp[i+2].real;
temp1l[i].imag=templi].imag+temp[i+2].imag;
temp1l[i+2].real=templi].real-temp[i+2].real;
templ[i+2].imag=templi].imag-temp[i+2].imag;
if(i==1)
i=3;

¥

for(i=4;i<8;i++)

{
b[i].real=temp1[i].real*wli-4].real-temp1[i].imag*wl[i-4].imag;
b[i].imag=temp1[i].real*w[i-4].imag+templ[i].imag*wl[i-4].real;
temp1l[i].real=b[i].real;
templ[i].imag=Dbl[i].imag;

b

for(i=0;i<4;i++)

{
y[i].real=temp1[i].real+temp1l[i+4].real;
yli].imag=temp1[i].imag+temp1l[i+4].imag;
y[i+4].real=templ[i].real-templ[i+4].real;
yli+4].imag=temp1[i].imag-temp1[i+4].imag;

b

printf("\nDFT values==\n");
for(i=0;i<8;i++)

printf("\nF(%d)=(%0.1f)+j(%0.1f)\n",i,y[i].real,y[i].imag);
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6) Design of FIR filter using windowing technique and verify the frequency response
of the filter

Program:

#include<stdio.h>

#include<math.h>

#define pi 3.1415

int n,N,c;

float wr[64],wt[64];

void main()

{ printf("\n enter no. of samples,N=:"); scanf("%d",&N);
printf("\n enter choice of window function\n 1.rect \n 2. triang \n c=:"); scanf("%d",&c);
printf("\n elements of window function are:");
switch(c)

{

case 1:

for(n=0;n<=N-1;n++)

{

wr[n]=1;

printf(" \n wr[%d]=%f",n,wr[n]);

}

break;

case 2:

for(n=0;n<=N-1;n++)

{

wit[n]=1-(2*(float)n/(N-1));

printf("\n wt[%d]=%f",n,wt[n]);

}

break;

1
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7 )Design of IIR filter using anyof the available methods and verify the
frequency response of the filter
Program:

INMRFILTERS USING C
#include<stdio.h>

#include<math.h>

int i,w,wc,c,N;

float H[100];

float mul(float, int);

void main()

{

printf("\n enter order of filter ");
scanf("%d",&N);

printf("\n enter the cutoff freq ");
scanf("%d",&wc);

printf("\n enter the choice for IIR filter 1. LPF 2.HPF ");
scanf("%d",&c);

switch(c)

{

case 1:

for(w=0;w<100;w++)

{

H[w]=1/sqrt(1+mul((w/(float)wc),2*N));
printf("H[%d]=%f\n",w,H[w]);

}

break;

case 2:

for(w=0;w<=100;w++)

{
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H[w]=1/sqrt(1+mul((float)wc/w,2*N));

printf("H[%d]=%An",w,H[Ww]);

}

break;

b

float mul(float a,int x)
{

for(i=0;i<x-1;i++)
a*=a;

return(a);

}
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8 ) Design of Analog filters
Program:

% IIR filters LPF & HPF

clc;

clear all;

close all;

warning off;

disp('enter the IIR filter design specifications');
rp=input(‘enter the passband ripple');
rs=input(‘enter the stopband ripple');
wp=input(‘enter the passband freq');
ws=input(‘enter the stopband freq');
fs=input('enter the sampling freq');
w1=2*wp/fs,w2=2*ws/fs;
[n,wn]=buttord(w1,w2,rp,rs,'s");
c=input(‘enter choice of filter 1. LPF 2. HPF \n ");
if(c==1)

disp('Frequency response of IIR LPF is:");
[b,a]=butter(n,wn,'low','s");

end

if(c==2)

disp('Frequency response of IIR HPF is:");
[b,a]=butter(n,wn,'high','s");

end

w=0:.01:pi;

[h,om]=freqs(b,a,w);

m=20%log10(abs(h));

an=angle(h);

figure,subplot(2,1,1);plot(om/pi,m);
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title('magnitude response of lIR filter is:');
xlabel('(a) Normalized freq. -->');
ylabel('Gain in dB-->'");
subplot(2,1,2);plot(om/pi,an);

title('phase response of IIR filter is:");
xlabel('(b) Normalized freq. -->');

ylabel('Phase in radians-->');//l/
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